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본 강의 자료는 한국생명정보학회가 주관하는 BIML 2026 워크샵을 목적으로 

제작된 것으로 해당 목적 이외의 다른 용도로 사용할 수 없음을 분명하게 알립니다.

이를 다른 사람과 공유하거나 복제, 배포, 전송할 수 없으며 만약 이러한 사항을 위반할 경우 

발생하는 모든 법적 책임은 행위자 본인에게 있음을 알립니다.



KSBi-BIML 2026
Bioinformatics & Machine Learning (BIML) Workshop for Life Scientists

한국생명정보학회가 주최하는 BIML-2026 동계 Bioinformatics &Machine Learning 교육 워크숍에 

여러분을 초대합니다. 

BIML 워크숍은 생명정보학 연구자들이 최신 AI바이오 분야의 인공지능 기반 분석 기술과 바이오 

데이터 분석 기법을 이론과 실습을 통해 체계적으로 배울 수 있는 전문 교육 프로그램입니다. 

2015년에 시작된 BIML 워크숍은 올해로 12년 차를 맞이하며, 국내 생명정보학 분야의 최초이자 최고 

수준의 교육 프로그램으로 자리 잡았습니다. 이번 워크숍은 크게 인공지능바이오(AI바이오) 분야와 

디지털바이오 분야, 두 분야로 구성됩니다. 

AI바이오 분야에서는 생명정보 분석에 폭넓게 응용되고 있는 다양한 인공지능 기반 자료 모델링 

기법을 다룰 예정입니다. 특히, 인공지능 심층학습을 활용한 단백질 구조 예측, 유전체 분석, 신약 

개발에 대한 이론 및 실습 강의가 진행됩니다. 

또한 디지털바이오 분야에서는 단일세포오믹스, 공간오믹스, 멀티오믹스, 메타오믹스에 대한 강의도 

마련되어 있어, 연구자들의 분석 역량 강화에 실질적인 도움을 줄 것으로 기대됩니다. 

또한 2024년부터 추가된 의료정보 자료 분석을 다루는 강의를 올해도 지속해서 운영하고자 합니다. 

이는 최근 의료정보 자료 분석에 관한 연구 수요 증가를 반영한 것으로, 관련 연구를 수행하는 

의과학자 및 의료정보 연구자들에게 유용한 지침을 제공할 것입니다. 

또한, 올해도 생명정보학 기술의 다양화에 발맞춰 온라인 강좌를 대폭 확대했습니다. 올해는 무료 

강좌 10개를 포함한 총 40개 이상의 강좌가 개설되며, 연구 주제에 맞는 강좌 추천과 강연료 할인 

혜택도 제공합니다.

BIML-2026는 국내 주요 연구 중심 대학의 전임 교수 및 각 분야 최고 전문가들의 강의로 구성되어 

있으며, 기초 이론부터 최신 연구 동향까지 아우르는 심도 있는 교육의 장이 될 것으로 확신합니다. 

여러분의 많은 관심과 참여를 기대합니다!

2026년 2월

한국생명정보학회장 류 성 호



강의개요

단백질 구조 예측
– 주형 기반 모델링부터 AlphaFold까지

생체 분자의 기능은 그 구조와 밀접한 관련을 가진다. 단백질의 기능 또한 그 구조로부터 밝힐 수 

있다. 따라서 X-선 결정학, 극저온 전자 현미경등 다양한 실험 기법들이 단백질의 구조를 밝히기 

위해 널리 사용되고 있다. 그러나 실험을 통해 모든 구조를 결정하기에는 어려움이 있고, 아미노

산 서열 규명에 비하여 높은 난이도를 가지므로, 이에 따라 sequence-structure gap이 발생하고 

있다.

본 강의에서는 아미노산 서열로부터 단백질의 3차원 구조를 예측하는 방법에 대하여 학습한다. 

2010년대 중반부까지 널리 사용되었던 주형 기반 모델링의 원리와 웹서버를 이용한 작동법을 익

힌다. 또한 최근의 동향인 심층학습기반 단백질 구조 예측에 대하여 학습하고, Colab을 이용한 간

단한 예측 방법에 대하여 실습한다.

강의는 다음의 내용을 포함한다:

  ⚫ 단백질 구조 예측 이론

  ⚫ Swiss-Model등 주형 기반 모델링 

  ⚫ AlphaFold등의 심층학습 기반 단백질 구조 예측

* 교육생준비물: 

  노트북

* 강의 난이도: 초급

* 강의: 신웅희교수 (고려대학교 의료정보학과)
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Speaker Name: Woong-Hee Shin, Ph.D.

▶ Personal Info

Name Woong-Hee Shin

Title Associate Professor

Affiliation Korea University

▶ Contact Information

Address 161, Jeungneung-Ro, Seongbuk-Gu, Seoul, 02708

Email whshin@korea.ac.kr

Research Interest

Computer-aided drug discovery, Protein design

Educational Experience

2008 B.S. in Chemistry, Seoul National University, Korea

2014 Ph.D. in Chemistry, Seoul National University, Korea

Professional Experience

2014-2019 Post-doc research fellow, Purdue University, USA

2019-2023 Assistant Professor, Department of Chemistry Education, Sunchon National University 

2023- Associate Professor, Department of Biomedical Informatics, Korea University 

College of Medicine
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1. Wonkyeong Jang and Woong-Hee Shin, CoBRA: Compound Binding Site Prediction using RNA 

Language Model, Briefings in Bioinformatics, In Press.

2. Jinung Song, Junsu Ha, Juyong Lee, Junsu Ko, and Woong-Hee Shin, Improving docking and 

virtual screening performance using AlphaFold2 multi-state modeling for kinases, Scientific 

Reports, 2024, 14, 25167.

3. Yiyu Hong, Junsu Ha, Chae-Jo Lim, Kwang-Seok Oh, Ramakrishana Chandrasekaran, Junsu Ko, 

Woong-Hee Shin, and Juyong Lee, Accurate Prediction of Protein-Ligand Intereactions by 

Combining Physical Energy Function and Graph-Neural Networks, Journal of Cheminformatics, 

2024, 16, 121.
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Need for Protein Structure Prediction  

• Protein Structure-Function Relationship 
• Similar structure, similar function 

Lecture Goal 

• Predict a protein 3D structure of your interest using web server and 
visualizing it 
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Need for Protein Structure Prediction  

Need for Protein Structure Prediction 

• Neuraminidase and Tamiflu 
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PDB (Protein Data Bank) 

• Protein structure database 
• rcsb.org 

Experimental Techniques 
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Searching a Specific Protein 

• Type your protein name, PDB ID, or any keyword such as the name of 
experimentalist 

PDB 

• Protein Data Bank 
• Structural database of proteins 
• Established in 1971 with 7 entries under the leadership of Walter 

Hamilton, Brookhaven National Laboratory 
• In 1998, Research Collaborative for Structural Bioinformatics became 

responsible for managing the DB  
• Worldwide PDB (wwPDB) was established to maintain the DB in 2003 
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Searching a Specific Protein 

PDB ID: 1 digit + 3 alphanumeric letters 

Biological information 

Structure 
quality 

Searching a Specific Protein 

• Select a protein structure from the summarized information 

Refine 
structure by 
selecting 
conditions 

Realign the 
results by 
changing 
sorting 
options such 
as resolution 

Summarize
d 
information 
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Searching a Specific Protein 

• Chain information 

 
 PDB Structure 

Chain 

Domain 

Residue 

Atom 

Searching a Specific Protein 

• Literature and molecular information 



- 8 -

Visualizing a Protein Structure 

• Click Explore in 3D: Structure 

Searching a Specific Protein 

• Hetero atom information 
• Noncanonical amino acid 
• Ligand 
• Ion 
• Etc. 
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Visualizing a Protein Structure 

Clicking specific 
residue focuses the 
viewer to the amino 
acid 

Modify the 
representation 
of the viewer 

Visualizing a Protein Structure 

• Holding left click: Rotating 
• Holding right click: Translation 
• Scrolling wheel: Zoom in / out 
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PDB 

• ATOM(amino acid)/HETATM(non AA) 
• Atom information 
• Indices 
• Amino acid information 
• x,y,z coordinate 

PDB 

• PDB file format 
• HEADER: Protein name, PDB ID, Date dep

osited in PDB 
• REMARK 

• Types of amino acids in the protein 
• Resolution 
• Organism 
• etc. 
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Visualizing a Protein Structure 

• Download PDB file or take a note of the PDB ID 

Visualizing a Protein Structure 

• Use ChimeraX (https://www.cgl.ucsf.edu/chimerax/) or PyMOL 
(https://www.pymol.org/) 
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Visualizing a Protein Structure 

• 1) If you have a PDB file 
• Click Open and find the file 

Visualizing a Protein Structure 

• Execute ChimeraX 
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Visualizing a Protein Structure 

 Holding left click: Rotating 

 Holding right click: Translation 

 Scrolling wheel: Zoom in / out 

  

Visualizing a Protein Structure 

• 2) If you know the PDB ID 
• Click File > Fetch By ID, select PDB, and put your ID 
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Visualizing a Protein Structure 

• Actions > Color can change the color of the atom, 
residue, structure, and background 

Visualizing a Protein Structure 

• Change the representation 
style using a panel 

• Capture the current screen by 
clicking the camera ion 
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Need for Protein Structure Prediction  

Visualizing a Protein Structure 

• Select a specific residue by Ctrl + click 
• Or if you know the residue number or name type sel :[residue] at the 

command line 
• Identifiers 

• # model 
• / chain  
• : residue  
• @ atom  

• Action > Focus zooms on the selected atoms 
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Levinthal’s Paradox 

• Nature favors the lowest energy state 

Protein Folding Problem 

• Predict 3D structure of a protein from a amino acid sequence 
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Levinthal’s Paradox 

• Time scale for protein folding 
• ~ ns, ps 
• For a protein with 100 residues, protein folding occurs in one step 
• Nature follows a specific pathway to fold the protein, not a random 

search 
• Folding funnel 

Levinthal’s Paradox 

• How to find the lowest energy conformation? 
• If the protein is composed of 100 residues, 
• Total number of cases if the three states allowed for a single residue 

backbone 
• 3100 

• Assuming that the protein can search 1012 number of possible states in 
one second, 

• 5X1035 seconds = 2X1028 years  
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Template-based Modeling 

• Template? It’s a cast for a shape 

Protein Structure Prediction 

• Let’s predict a protein structure if it is not available 
• But as you can see in Levinthal’s paradox, it is too much inefficient that 

search all the possible conformational states 
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Template-based Modeling 

• Flow of TBM 

Template-based Modeling 

• Basic idea: similar sequence → similar structure 
• Lowest bound: 20-25% 
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Where to Find My Sequence? 

• Search UniProt with a protein name (uniprot.org) 

 

Template-based Modeling 

• Template Detection 
• Find proteins with structures that are similar with our target 

proteins 
 

• Sequence Alignment 
• Detect the similar environment of templates to our 

sequence 
 

• Model Building 
• Build 3D structure from template information 
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Where to Find My Sequence? 

Where to Find My Sequence? 

• Click Entry in the result page (Beware of Organism) 
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Where to Find My Sequence? 

• Copy the text or right-click and select save as 

Where to Find My Sequence? 

• Click Sequence on the left side and click FASTA on the main page 
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Template-based Modeling 

• Modeller 

Template-based Modeling 

• Modeller (salilab.org/modeller) 
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SWISS-MODEL 

• https://swissmodel.expasy.org/ 

 

Template-based Modeling 

• How Modeller works 
 

• Spatial restraints 
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SWISS-MODEL 

• Can see the template by clicking Search For Templates. 
• The templates are identified by HHBlits 

SWISS-MODEL 

• Click Start Modeling 
• Paste your sequence or upload a text file that contains the sequence 
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SWISS-MODEL 

• Download the result by selecting the downward arrow 

SWISS-MODEL 

• Select templates with clicking check boxes on the 
left and click Build Models to predict structure from 
the selected proteins 
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SWISS-MODEL 

• MolProbity Score 
• How protein-like is the 

structure? 
• The lower, the better 

 

SWISS-MODEL 

• Can check the quality of the predicted structure by selecting Structure 
Assessment on the left side 
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Template-based Modeling 

• After submitting your sequence… 

Template-based Modeling 

• GalaxyTBM 
• http://galaxy.seoklab.org/cgi-bin/submit.cgi?type=TBM 
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Recent Method using  
Deep Learning 

Template-based Modeling 
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Protein Structure Prediction: Deep-Learning Revolution 

“for computational protein design” 

David Baker 

“for protein structure prediction” 

Demis Hassabis John Jumper https://www.nobelprize.org/all-nobel-prizes-2024/ 

인공지능과 심층학습: AlphaGo 

• AlphaGo: 기보 + 강화학습 
• AlphaGo Zero: 규칙 + 강화학습 
• AlphaZero: 일반화 (장기, 체스…) 
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CASP 

• Biannual structure prediction contest, blinded 

Protein Structure Prediction: Deep-Learning Revolution 

 AlphaFold3 (2024)  RFantibody (2024) 

 Complex Modeling  Protein Design  Antibody Design 

 RFpeptide (2025) 

 Macrocyclic Peptide Design 

 RFdiffusion (2023) 
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CASP 

• Targets of CASP16  

CASP 

Prediction Categories of CASP16 
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CASP: AlphaFold Revolution 

CASP16 
Monomer 
prediction 
6th 

CASP16  
Complex prediction 
10th 

CASP16  
RNA prediction 
9th 

CASP: AlphaFold Revolution 

• AlphaFold2 from DeepMind dominates! 

CASP14 
(2020) 
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Getting Information from MSA 

• Coevolution and contact map: deep learning with structural database 

Flow of AlphaFold2 

• How AF2 works 
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AF2 Structure Database 

• EBI-AF2 database (https://alphafold.ebi.ac.uk/) 

 

Variants of AF2  
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AF2 Structure Database 

• pLDDT shows the reliability of a residue 
• Can see a detailed structure with your mouse 

AF2 Structure Database 

• Search with protein name or UniProt AC 
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ColabFold: AF2 Opened to Public 

AF2 Structure Database 

• If you are working on the proteome, get all proteins of an organism by cl
icking download 
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ColabFold 

• Put sequence and jobname, click Runtime > Run all  

ColabFold 

• https://colab.research.google.com/github/sokrypton/ColabFold/blob/m
ain/AlphaFold2.ipynb 
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Modeling using ChimeraX 

• ChimeraX supports ColabFold or retrieving AlphaFold DB 
• Get models from DB 

ColabFold 

• Five predicted models are zipped and downloaded automatically 
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Modeling using ChimeraX 

• Tools > Structure prediction > 
AlphaFold opens a colab page 

Or 
• Type in command line: 
alphafold predict sequence 

Modeling using ChimeraX 

• Result of alphafold fetch p29474 
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AlphaFold3 

• AlphaFold3 published in Nature! 

Comparing Structures using ChimeraX 

• Tools > Structure Analysis > Matchmaker 
Or 
• mmaker #model1 to #model2 
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AlphaFold3 

• Now it can deal with complex structures 

AlphaFold3 

• Adopts diffusion model for structure prediction 
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AF3 Webserver 

• Select the molecule type, put your target sequence 
• To model the complex, add entity 

AlphaFold3 

• AlphaFold3 webserver and policies (https://alphafoldserver.com/) 
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AF3 Webserver 

• Job limitations 
• 30 jobs / day 
• 5000 tokens / day 

• One amino acid, one base = 1 token 
• One atom for small molecule = 1 token 

AF3 Webserver 
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ESMFold 

• Structure database (esmatlas.com) 

ESMFold 

• by Meta 
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ESMFold 

• Paste sequence and click the magnifying glass 

ESMFold 

• Structure prediction using ESMFold 
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RoseTTAFold 

• D. Baker of UW 

ESMFold 
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RoseTTAFold 

• RoseTTAFold-AA 




